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using this
manual

This user manual has been specially designed to
guide you through the functions and features of your
mobile phone. To get started quickly,

refer to “introducing your mobile phone,”
‘assembling and preparing your mobile phone,”

and “using basic functions.”

Instructional icons

Before you start, familiarise yourself with the icons
you will see in this manual:

WARNING

A

CAUTION
4

>

Warning —situations that could cause
injury to yourself or others

Caution —situations that could cause
damage to your phone or other equipment

Note—notes, usage tips, or additional
information

Refer to—pages with related information;
for example: » p. 12 (represents “see page
127)



Followed by—the order of options or
menus you must select to perform a step;
for example: In Menu mode, touch
Messages — Create message
(represents Messages, followed by
Create message)

Square brackets —phone keys; for
example: [*o*] (represents the Power/
Menu exit key)

Copyright information

Rights to all technologies and products that
comprise this phone are the property of their
respective owners:

e Bluetooth® is a registered trademark of the
Bluetooth SIG, Inc. worldwide.

Bluetooth QD ID: BO15743
e Java™ is a trademark of Sun Microsystems, Inc.

o Windows Media Player® is a registered trademark
of Microsoft Corporation.
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safety ana
usage
iNformation

Comply with the following precautions to avoid
dangerous or illegal situations and ensure peak
performance of your mobile phone.

& Safety warnings

Keep your phone away from small
children and pets
Keep your phone and all accessories out of the

reach of small children or animals. Small parts may
cause choking or serious injury if swallowed.
Protect your hearing
Listening to a headset at high volumes
& can damage your hearing. Use only the
minimum volume setting necessary to

hear your conversation or music.
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Install mobile phones and equipment
with caution

Ensure that any mobile phones or related equipment
installed in your vehicle are securely mounted. Avoid
placing your phone and accessories near or in an air
bag deployment area. Improperly installed wireless
equipment can cause serious injury when air bags
inflate rapidly.

Handle and dispose of batteries and
chargers with care

e Use only Samsung-approved batteries and
chargers specifically designed for your phone.
Incompatible batteries and chargers can cause
serious injuries or damage to your phone.

e Never dispose of batteries or phones in a fire.
Follow all local regulations when disposing of
used batteries or phones.

e Never place batteries or phones on or in heating
devices, such as microwave ovens, stoves, or
radiators. Batteries may explode when
overheated.

e Never crush or puncture the battery. Avoid
exposing the battery to high external pressure,
which can lead to an internal short circuit and
overheating.

Avoid interference with pacemakers

Maintain a minimum of 15 cm (6 inches) between
mobile phones and pacemakers to avoid potential
interference, as recommended by manufacturers
and the independent research group, Wireless
Technology Research. If you have any reason to
suspect that your phone is interfering with a
pacemaker or other medical device, turn off the
phone immediately and contact the manufacturer of
the pacemaker or medical device for guidance.



Turn off the phone in potentially
explosive environments

Do not use your phone at refuelling points (service
stations) or near fuels or chemicals. Tumn off your
phone whenever directed by waming signs or
instructions. Your phone could cause explosions or
fire in and around fuel or chemical storage and
transfer areas or blasting areas. Do not store or carry
flammable liquids, gases, or explosive materials in
the same compartment as the phone, its parts, or
accessories.

Reduce the risk of repetitive motion
injuries

While using your phone, hold the phone with a
relaxed grip, press the keys lightly, use special
features that reduce the number of keys you have to
press (such as templates and predictive text), and
take frequent breaks.

Do not use the phone if the screen is
cracked or broken

Broken glass or acrylic could cause injury to your
hand and face. Bring the phone to a Samsung
service centre to replace the screen. Damage
caused by careless handling will void your
manufacturer's warranty.

uoneuLou ebesn pue Aejes .
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& Safety precautions

CAUTION

Drive safely at all times

Avoid using your phone while driving and obey all
regulations that restrict the use of mobile phones
while driving. Use hands-free accessories to
increase your safety when possible.

Follow all safety warnings and
regulations

Comply with any regulations that restrict the use of a
mobile phone in a certain area.

Use only Samsung-approved
accessories

Using incompatible accessories may damage your
phone or cause injury.

4

Turn off the phone near medical
equipment

Your phone can interfere with medical equipment in
hospitals or health care facilities. Follow all
regulations, posted warnings, and directions from
medical personnel.

Turn off the phone or disable the
wireless functions when in an aircraft

Your phone can cause interference with aircraft
equipment. Follow all airline regulations and turn off
your phone or switch to a mode that disables the
wireless functions when directed by airline
personnel.



Protect batteries and chargers from
damage

Avoid exposing batteries to very cold or very hot
temperatures (below 0° C/32° F or above 45° C/
113° F). Extreme temperatures can reduce the
charging capacity and life of your batteries.
Prevent batteries from contacting metal objects,
as this can create a connection between the +
and - terminals of your batteries and lead to
temporary or permanent battery damage.

Never use a damaged charger or battery.

Handle your phone carefully and
sensibly

Do not disassemble your phone due to a risk of
electric shock.

Do not allow your phone to get wet—liquids can
cause serious damage and will change the colour
of the label that indicates water damage inside the
phone. Do not handle your phone with wet
hands. Water damage to your phone can void
your manufacturer's warranty.

Avoid using or storing your phone in dusty, dirty
areas to prevent damage to moving parts.

Your phone is a complex electronic device—
protect it from impacts and rough handling to
avoid serious damage.

Do not paint your phone, as paint can clog
moving parts and prevent proper operation.

uoneuLou ebesn pue Aejes .
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e |f your phone has a camera or light, avoid using it
close to the eyes of children or animals.

e Your phone may be damaged by exposure to
magnetic fields. Do not use carrying cases or
accessories with magnetic closures or allow your
phone to come in contact with magnetic fields for
extended periods of time.

Avoid interference with other electronic
devices

Your phone emits radio frequency (RF) signals that
may interfere with unshielded or improperly shielded
electronic equipment, such as pacemakers, hearing
aids, medical devices, and other electronic devices
in homes or vehicles. Consult the manufacturers of
your electronic devices to solve any interference
problems you experience.

Important usage information

Use your phone in the normal position
Avoid contact with your phone’s internal antenna.

Allow only qualified personnel to service
your phone

Allowing unqualified personnel to service your phone
may result in damage to your phone and will void
your warranty.

Ensure maximum battery and charger

life

e Avoid charging batteries for more than a week, as
overcharging may shorten battery life.

e Qver time, unused batteries will discharge and
must be recharged before use.



® Disconnect chargers from power sources when
not in use.

e Use batteries only for their intended purpose.

Handle SIM cards and memory cards

with care

e Do not remove a card while the phone is
transferring or accessing information, as this
could result in loss of data and/or damage to the
card or phone.

® Protect cards from strong shocks, static

electricity, and electrical noise from other devices.

Frequent writing and erasing will shorten the life
span of memory cards.

Do not touch gold-coloured contacts or terminals
with your fingers or metal objects. If dirty, wipe the
card with a soft cloth.

Ensure access to emergency services

Emergency calls from your phone may not be
possible in some areas or circumstances. Before
travelling in remote or undeveloped areas, plan an
alternate method of contacting emergency services
personnel.

Specific Absorption Rate (SAR)
certification information

Your phone conforms to European Union (EU)
standards that limit human exposure to radio
frequency (RF) energy emitted by radio and
telecommunications equipment. These standards
prevent the sale of mobile phones that exceed a
maximum exposure level (known as the Specific
Absorption Rate, or SAR) of 2.0 W/kg.

uoneuLou ebesn pue Aejes .



uoneuLojul ebesn pue Aejes .

During testing, the maximum SAR recorded for this
model was 0.752 W/kg. In normal use, the actual
SAR is likely to be much lower, as the phone has
been designed to emit only the RF energy necessary
to transmit a signal to the nearest base station. By
automatically emitting lower levels when possible,
your phone reduces your overall exposure to RF
energy.

The Declaration of Conformity at the back of this
manual demonstrates your phones compliance with
the European Radio & Terminal Telecommunications
Equipment (R&TTE) directive. For more information
about the SAR and related EU standards, visit the
Samsung mobile phone website.

Correct disposal of this product
(Waste Electrical & Electronic Equipment)

(Applicable in the European Union and
other European countries with separate
collection systems)
mmmm 'Nis marking on the product, accessories
or literature indicates that the product and
its electronic accessories (e.g. charger, headset,
USB cable) should not be disposed of with other
household waste at the end of their working life. To
prevent possible harm to the environment or human
health from uncontrolled waste disposal, please
separate these items from other types of waste and
recycle them responsibly to promote the sustainable
reuse of material resources.



Household users should contact either the retailer
where they purchased this product, or their local
government office, for details of where and how they
can take these items for environmentally safe
recycling.

Business users should contact their supplier and
check the terms and conditions of the purchase
contract. This product and its electronic accessories
should not be mixed with other commercial wastes
for disposal.

Correct disposal of batteries in this
product
(Applicable in the European Union and
other European countries with separate
pattery return systems)

This marking on the battery, manual or
packaging indicates that the batteries in this product
should not be disposed of with other household
waste at the end of their working life. Where marked,
the chemical symbols Hg, Cd or Pb indicate that the
battery contains mercury, cadmium or lead above
the reference levels in EC Directive 2006/66. If
batteries are not properly disposed of, these
substances can cause harm to human health or the
environment.

To protect natural resources and to promote material
reuse, please separate batteries from other types of
waste and recycle them through your local, free
battery return system.

uoneuLou ebesn pue Aejes .
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Disclaimer

Some contents and services accessible through this
device belong to third parties and are protected by
copyright, patent, trademark and/or other intellectual
property laws. Such content and services are
provided solely for your personal noncommercial
use. You may not use any content or services in a
manner that has not been authorised by the content
owner or service provider, Without limiting the
foregoing, unless expressly authorised by the
applicable content owner or service provider, you
may not modify, copy, republish, upload, post,
transmit, translate, sell, create derivative works,
exploit, or distribute in any manner or medium any
content or services displayed through this device.
THIRD PARTY CONTENT AND SERVICES ARE
PROVIDED "AS IS." SAMSUNG DOES NOT

WARRANT CONTENT OR SERVICES SO
PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY,

10

FOR ANY PURPOSE. SAMSUNG EXPRESSLY
DISCLAIMS ANY IMPLIED WARRANTIES,
INCLUDING BUT NOT LIMITED TO, WARRANTIES
OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. SAMSUNG DOES NOT
GUARANTEE THE ACCURACY, VALIDITY,
TIMELINESS, LEGALITY, OR COMPLETENESS OF
ANY CONTENT OR SERVICE MADE AVAILABLE
THROUGH THIS DEVICE AND UNDER NO
CIRCUMSTANCES, INCLUDING NEGLIGENCE,
SHALL SAMSUNG BE LIABLE, WHETHER IN
CONTRACT OR TORT, FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES, ATTORNEY FEES,
EXPENSES, OR ANY OTHER DAMAGES ARISING
OUT OF, OR IN CONNECTION WITH, ANY
INFORMATION CONTAINED IN, OR AS A RESULT
OF THE USE OF ANY CONTENT OR SERVICE BY
YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES."



Third party services may be terminated or interrupted
at any time, and Samsung makes no representation
or warranty that any content or service will remain
available for any period of time. Content and
services are transmitted by third parties by means of
networks and transmission facilities over which
Samsung has no control. Without limiting the
generality of this disclaimer, Samsung expressly
disclaims any responsibility or liability for any
interruption or suspension of any content or service
made available through this device.

Samsung is neither responsible nor liable for
customer service related to the content and
services. Any question or request for service relating
to the content or services should be made directly to
the respective content and service providers.

11
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iNtroducing your
mobile phone

In this section, leam about your mobile phone’s layout,
keys, and icons.

12

Unpack

Check your product box for the following items:

e Mobile phone

e Battery

e Travel adapter (charger)

e User manual

'g e The items suppHed with your phone may
vary depending on the software and
accessories available in your region or
offered by your service provider. You can
obtain additional accessories from your local
Samsung dealer.

* The supplied accessories perform best for

your phone.



Phone layo

ut

The front of your phone includes the following keys

and features:

Earpiece

Volume key —

Multifunction —s

jack

Dial key—

e

I
(=07

Touch screen

Back key

Power/Menu
exit key

Mouthpiece

The rear of your phone includes the following keys

and features:

&

Hold key —

Camera key —

"

I4

screen.

Camera lens

aR

Battery cover

k% s—Internal
Speaker—\%k/ antenna

You can lock the touch screen and keys to

prevent any unwanted phone operations. To
lock, press [HOLD]. To unlock, press and hold
[HOLD], or touch and hold the lock icon on the
13

)

auoyd ajiqow InoA Bupnpoaul .



suoyd sjigow JnoA Bupnpoaul .

Keys

Key

Dial

Function

Meake or answer a call; In Idle mode,
retrieve recently dialled, missed, or
received numbers

Back

In Menu mode, retum to the previous
level

a Q| a

Power/
Menu exit

Tum the phone on and off (press and
hold); End a call; In Menu mode,
cancel input and retum to Idle mode

=

Volume

Adjust the phone's volume; In Idie
mode, press and hold the Volume
key down to make a fake call

[ro)

Hold

Lock the touch screen and keys;
Unlock the touch screen and keys
(press and hold)

Key

Function
In Idle mode, tum on the camera; In

Camera Camera mode, take a photo or

record a video

Icons

LLearn about the icons that appear on your display.

Icon Definition

Shdl  Signal strength

fad SOS message feature activated
GPRS network connected

@  EDCE network connected

%

Call in progress

14



Icon Definition

Icon Definition

&  Browsing the web @)  Alam activated

@ Connected to secured web page @ Memory card inserted
©  Calldverting activated o]  Normal profile activated
§ Blustooth activated ¥]  Sient profie activated
iy E(I)umesgggdhands-free car kit or headset T —

& Synchronised with PC Current time

g New text message (SMS)

New multimedia message (MMS)

) New emalil message

New voice mail message

15
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assempling and
oreparnng your
mobile phone

Get started by assembling and setting up your mobile
phone for its first use.

16

Install the SIM card and battery

When you subscribe to a cellular service, you will
receive a Subscriber Identity Module (SIM) card with
subscription details, such as your personal
identification number (PIN) and optional services.

To install the SIM card and battery,
1. Remove the battery cover.

If the phone is on, press and hold [*&™] to tum

r’g it off.



2. Insert the SIM card.

',g

® Place the SIM card in the phone with the
gold-coloured contacts facing down.

o Without inserting a SIM card, you can use
your phone’s non-network services and
Some menus.

3. Insert the battery.

4. Replace the battery cover.

<

y:

17
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Charge the battery

Before using the phone for the first time, you must
charge the battery.

1. Open the cover to the multifunction jack.

2. Plug the small end of the travel adapter into the
multifunction jack.

CAUTION

18

With the triangle
facing up ﬁ
%

Improperly connecting the travel adapter can
cause serious damage to the phone. Any
damages by misuse are not covered by the
warranty.

3. Plug the large end of the travel adapter into a
power outlet.

4. \When the battery is fully charged (the icon is
no longer moving), unplug the travel adapter from
the power outlet.

5. Unplug the travel adapter from the phone.
6. Close the cover to the multifunction jack.

'g About the low battery indicator

When your battery is low, the phone will emit a
warmning tone and a low battery message. The
pattery icon will also be empty and blinking. If
the battery level becomes too low, the phone
will automatically power off. Recharge your
pattery to continue using your phone.



Insert a memory card (optional)

To store additional multimedia files, you must insert a

memory card. Your phone accepts microSD™ or

microSDHC™ memory cards up to 8 GB

(depending on memory card manufacturer and

type).

Formatting the memory card on a PC may
cause incompatibility with your phone. Format
the memory card only on the phone.

1. Remove the battery cover.

2. Insert a memory card with the label side facing
up.

3. Push the memory card in the memory card slot
until it locks in place.

4, Replace the battery cover.

To remove the memory card, push it gently until it
disengages from the phone, and then pull the
memory card out of the memory card slot.

19
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Remove the battery cover.
2. Slide a hand strap through the slot and hook

over the small projection.

Attach a hand strap (optional)

1.

3. Replace the battery cover.

assembiling and preparing your mobile phone

20



using bbasic
functions

LLeam how to perform basic operations and use the
main features of your mobile phone.

Turn your phone on and off
To turn your phone on,
1. Press and hold [5™].

2. Enter your PIN and select Confirm (if necessary).
To turn your phone off, repeat step 1 above.

Switch to the offline profile

By switching to the offline profile, you can use your
phone’s non-network services in areas where
wireless devices are prohibited, such as aeroplane
and hospitals.

To switch to the offline profile, in Menu mode, select
Settings — Phone profiles — Offline.
w Follow all posted wamnings and directions from

official personnel when in areas where wireless
devices are prohibited.




Use the touch screen e Drag your finger up or down to scroll through
vertical lists.

Your phone’s touch screen lets you easily select
items or perform functions. Learn basic actions to
use the touch screen.

r,, For the optimal use of the touch screen,
d remove the screen protection film before using
your phone. ‘

e Touch an icon to open a menu or launch an

application. e Drag your finger left or right to scroll through

horizontal lists.

c
Q.
=

(]
g
@
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c
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2
o
>
(7]
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Access menus

To access your phone’s menus,

1. InIdle mode, select Menu to access Menu
mode.

2. Scroll left or right through the menu screens.
3. Select a menu or option.

4. Press the Back key to move up one level; Press
[7@™] to retumn to Idle mode.

Use widgets

Leamn to use widgets on the toolbar.

r,, e Some of your widgets connect to web
J services. Selecting a web-based widget may
incur additional charges.
o Avallable widgets may vary depending on
your region or service provider.

Open the widget toolbar

In Idle mode, select the arrow at the bottom left of
the screen to open the widget toolbar. You can
rearrange widgets on the widget toolbar or move
them to the idle screen.

Move the widgets to the idle screen

1. InIdle mode, scroll left or right to one of the idle
screens.

2. Open the widget toolbar.

3. Drag a widget from the widget toolbar to the idle
screen. You can position the widget anywhere
on the screen.

Change the widgets

1. Open the widget toolbar.

2. Select &g from the widget toolbar.

3. Select the widgets you want to include to the

widget toolbar and select Save. 23
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Access help information

LLearn to access helpful information about your
phone.

1. Open the widget toolbar.
2. Select | 7| from the widget toolbar.

3. Rotate the phone anti-clockwise to landscape
view.

4. Select a help topic to learn about an application
or feature.

5. Scroll left or right to get more information. To retumn
to the previous level, select [#].

Customise your phone

Get more from your phone by customising it to
match your preferences.

24

Adjust the volume of the key tones

In Idle mode, press the Volume key up or down and
adjust the key tone volume.

Adjust the vibration intensity on the
touch screen

You can adjust the intensity of the vibration when you
tap the phone screen.

1. InIdle mode, press the Volume key.
2. Select Vibration and press the Volume key and

adjust the intensity of the vibration.
Switch to or from the silent profile

In Idle mode, select Keypad and touch and hold #
to silence or unsilence your phone.



Change your ringtone

1. In Menu mode, select Settings — Phone
profiles.

2. Select [» next to the profile you are using.

rg If you are using the silent or oﬁline profile, you
are not allowed to change the ringtone.

3. Select Voice call ringtone.

4. Select a ringtone from the list and select Save.

5. Select Save.

To switch to another profile, select it from the list.

Select a wallpaper (Idle mode)

1. In Menu mode, select Settings — Display and
light > Wallpaper.

2. Scroll left or right to an image.
3. Select Set.

Select a skin color (Menu mode)

1. In Menu mode, select Settings — Display and
light > My theme.

2. Select a color pattemn.
3. Select Save.

Lock your phone
1. In Menu mode, select Settings — Security.
2. Select On under Phone lock.

3. Enter a new 4- to 8-digit password and select
Confirm.

4. Enter the new password again and select
Confirm.

r,, e The first ime you access a menu that
’ requires a password, you will be prompted to
create and confirm a password.
® Samsung is not responsible for any loss of
passwords or private information or other
damages caused by illegal software. 25
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Unlock the touch screen with smart
unlock

By drawing a specified character on the locked
touch screen, you can unlock the screen only,
unlock and then make a call to a speed dial number,
or unlock and then launch an application. To set a
smart unlock character,

1. In Menu mode, select Settings — Smart
unlock.

2. Select On under Gesture unlock.
3. Select an unlock option.

4. Select a speed dial number to dial or select an
application to launch (if necessary).

5. Select a character for the smart unlock feature.
6. Select the Back key (if necessary).
7. Select Save.

Use basic call functions

LLearn to make or answer calls and use basic call
functions.

',, During a call, your phone automatically locks
’ the touch screen to prevent accidental inputs.
To unlock, press and hold [HOLD].

Make a call

1. Inldle mode, select Keypad and enter an area
code and a phone number.

2. Press [«] to dial the number.
3. Toend the call, press [*&*].

Answer a call
1. When a call comes in, press [«].
2. To end the call, press [7&*].



Adjust the volume

To adjust the volume during a call, press the Volume
key up or down.

Use the speakerphone feature

1. During a call, select Speaker — Yes to activate
the speaker.

2. To switch back to the earpiece, select Speaker
again.
w In noisy environments, you may have difficulty
> N f N
hearing the calls while using the speakerphone
feature. For better performance, use the normal
phone mode.

Use the headset

By plugging the supplied headset into the
multifunction jack, you can make and answer calls:

e 7o redial the last call, press and hold the headset
button, and then press again and hold.

e To answer a call, press the headset button.

e To end a call, press and hold the headset button.

Send and view messages

Learn to send or view text (SMS), multimedia (MMS),
or email messages.

Send a text or multimedia message

1. In Menu mode, select Messages — Create
message — Message.

2. Select Tap to add recipient — Enter manually.
3. Enter a recipient number and select Done.

27
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Select Tap to add text.

Enter your message text and select Done.

» Enter text

For sending as a text message, skip to step 7.
For attaching multimedia, continue with step 6.

6. Select Add media and add an item.

7.

Select Send to send the message.

Send an email

. In Menu mode, select Messages — Create

message —> Email.

Select Tap to add recipient > Enter manually.
Enter an email address and select Done.

Select Tap to add subject.

Enter a subject and select Done.

Select Tap to add text.

7. Enter your email text and select Done.
8. Select Add files and attach a file (if necessary).
9. Select Send to send the message.

Enter text

When entering text, you can change the text input
mode:

e To change case or switch to Number or Symbol
mode, select T9Ab at the bottom centre of the
screen. Depending on your region, you may be
able to access an input mode for your specific
language.

e To enter text in T9 mode, select T9.

¢ To switch to Symbol mode, select (@].



Enter text in one of the following modes:

Select an appropriate virtual key until the
ABC .
character you want appears on the display.

1. Select the appropriate virtual keys to
enter an entire word.
2. When the word displays correctly, select
T9 .
1 10 insert a space. If the correct word
does not display, select w and an
alternate word from the list that appears.

Select an appropriate virtual key to enter a

Nurmioer number.

Select an appropriate virtual key to enter a

Symol symbol.

View text or multimedia messages

1.
2.

In Menu mode, select Messages — Inbox.
Select a text or multimedia message.

View an email

1.

o~ wN

In Menu mode, select Messages — Email
inbox.

Select an account.
Select Download.
Select an email or a header.

If you selected a header, select Retrieve to view
the body of the email.
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Add and find contacts

LLearn the basics of using the phonebook feature.

Add a new contact

1. Inldle mode, select Keypad and enter a phone
number.

Select =] — Add to Phonebook — New.
Select Phone or SIM.

Enter contact information.

Select Save to add the contact to memory.

SERFCI SN

Find a contact
1. In Menu mode, select Phonebook.

2. Select the search field, enter the first few letters
of the name you want to find, and select Done.
You can also drag il to select the first letter of the
name.

30

3. Select the contact's name from the search list.
@ Once you have found a contact, you can:

* call the contact by selecting [ — 4
¢ edit the contact information by selecting Edit

Use basic camera functions

LLearn the basics to capture and view photos and
videos.

Capture photos
1. InIdle mode, press [[81] to tun on the camera.
2. Rotate the phone anti-clockwise to landscape
view.
3. Aim the lens at the subject and make any
adjustments.
* To select the time delay, select &.
e To set the exposure value, select &,



4. Press [@3] to take a photo.
The photo is saved automatically.
After capturing photos, select (*] to view photos.

View photos

In Menu mode, select My files — Images — My
photos — a photo file.

To zoom in or out,

e touch and hold the screen. When % appears,
scroll up or down.

To exit the zoom screen, press the Back key.

Capture videos
1. InIdle mode, press [[@1] to turn on the camera.
2. Select (@] to switch to Recording mode.

3. Rotate the phone anti-clockwise to landscape
view.

4. Aim the lens at the subject and make any
adjustments.
e To charge the recording mode, select [m.
e To select the time delay, select &.
e To set the exposure value, select &,

5. Press [@1] to start recording.

6. Press @ or [(81] to stop recording.
The video is saved automatically.

After capturing videos, select (] to view videos.

View videos

In Menu mode, select My files — Videos —~ My
video clips — a video file.
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Listen to music 4. Control the FM radio using the following icons:

Learn how to listen to music via the music player or

FM radio = Select a radio station saved in the favourite
' B step. 47
Listen to the FM radio Set your phone 1o re-tune frequencies for
) ) , stations; Set your phone to switch to

1. P\ug‘ the supplled headset into the phone’s E another channel of the current radio station
% muitifunction jack. when signals become too weak
% 2. In Menu mode, select FM radio. E Change the sound output
% 3. Select Yes to start automatic tgnlng. . Tune a radio station; Select a saved radio
% Th;a radLQ s‘(lzans and saves available stations $ ¥ qiat0n (touch and hold)
§ a Oma.\ca y ' ‘ > Turn on the FM radio
o ’g The first time you turn on the FM radio, you will = -

be prompted to start automatic tuning. @ Tumoff the FM radio

5. To tum off the FM radio, select (a).
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Listen to music files

Start by transferring files to your phone or memory
card:

Download from the wireless web. » p. 34

Download from a PC with the optional Samsung
PC Studio. » p. 45

Receive via Bluetooth. » p. 50
Copy to your memory card. » p. 45

Synchronise with Windows Media Player 11.
» p. 46

After transferring music files to your phone or
memory card,
1. In Menu mode, select Music player.
2. Select a music category = a music file.
3. Control playback using the following icons:
Icon Function
) Pause playback
©) Resume playback

@ Skip backward; Scan backward in a file
(touch and hold)

@ Skip forward; Scan forward in a file (touch
and hold)
NORM  Change the sound effect
A Change the repeat mode

CgD  Activate Shuffle mode

33
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Browse the web Browse web pages

Learn to access and bookmark your favourite web 1. InMenu mode, select Internet > Home to
pages. launch your service provider's homepage.
r,, * You may incur additional charges for 2. Navigate web pages using the following icons:
£/] accessing the web and downloading meda.
* The browser mengs may be \abellgad Y Move backward or forward on a web
& differently depending on your service page
= provider. Stop loading the web
g * Avallable icons may vary depending on your X Op loading the web page
8 region or service provider. Q Refresh the current web page
% g Change the view mode
§ Open a list of saved bookmarks
[}

Change the web page to the landscape
orientation

w0 *

Access a list of browser options

34




Bookmark your favourite web pages

1. In Menu mode, select Internet -~ Bookmarks.

2. Select Add.
3. Enter a web address (URL) and a page title.
4. Select Save.

Use the Google services

LLearn how to use various Google services.

@ ® Some services may be unavailable
depending on your region or service
provider.

e The steps you must select to use this
feature may differ depending on your region
or service provider.

Connect to Google Search
1. In Menu mode, select Google — Search.
2. Enter a keyword in the search field.

Connect to Google Mail

1. In Menu mode, select Google — Mail.
2. Set up your Google account and sign in.
3. Send or receive emalls.
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Connect to Google Maps

To search the map,

1. In Menu mode, select Google — Maps.
2. Scroll through the map.

3. Zoom in or out on the location you want.
To search for a specific location,

1. In Menu mode, select Google — Maps.

2. Select Menu — Search Map and enter the
address or the category of the business.

To get directions to a specific destination,
1. In Menu mode, select Google — Maps.
2. Select Menu — Get Directions.

3. Enter the addresses of the starting location and
the ending location.

4, Select Show directions to view on the map.
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using advanceo
functions

Leam how to
ac

Use advanced call functions

LLearn about your phone'’s additional calling
capabilities.

View and dial missed calls

Your phone will display calls you have missed on the
display. To dial the number of a missed call,

1. Select the missed call you want to dial from the
event alert widget.

2. Press [«] to dial.

Call a recently dialled number

1. Inldle mode, press [«—] to display a list of
recent numbers.

2. Select to the number you want and select [ or
press [#—] to dial.
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Hold a call or retrieve a held call

Select Hold to place a call on hold or select
Retrieve to retrieve a held call.

Dial a second call

If your network supports this function, you can dial
another number during a call:

1. Select Hold to place the first call on hold.

2. Enter the second number to dial and press
[—].

3. Select Swap to switch between the two calls.

4, Toend the call on hold, select On hold and
press [T).

5. Toend the current call, press [7&*].

38

Answer a second call

If your network supports this function, you can
answer a second incoming call:

1. Press [=] to answer the second call.
The first call is automatically placed on hold.
2. Select Swap to switch between the calls.

Make a multiparty call (conference call)

1. Call the first party you want to add to the
multiparty call.

2. While connected to the first party, call the
second party.
The first party is automatically placed on hold.

3. When connected to the second party, select
Join.

4. Repeat steps 2 and 3 to add more parties (if
necessary).

5. To end the multiparty call, press [*&*].



Call an international number Reject a call
1. Inldle mode, select Keypad and touch and hold To reject an incoming call, press [7&*]. The caller will

0 to insert the + character. hear a busy tone.
2. Enter the complete number you want to dial To reject calls from certain numbers automatically,
(country code, area code, and phone number), use the auto rejection. To activate the auto rejection
and then press [«—] to dial. and set up the reject list,
0 H i c
Call a contact from the phonebook 1. 1In M_enu mode, select Settings — App_llcatlon o
‘ settings — Call — All calls — Auto reject. @
Yoy can call numbers directly from the phonebook 5. Select On under Activation. ]
using stored contacts. » p. 30 2
3. Select Add number under Reject list. 3
1. In Menu mode, select Phonebook. ) ‘ =
4. Select the number input field. g
2. Select the contact you want. ) 3
) 5. Enter a number to reject and select Done — o
3. Select B4 next to the number you want to dial — Save @
] .
6. Repeat steps 3-5 to add more numbers.
7. Select the check boxes next to the number.

8. Select Save.
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Use advanced phonebook functions

LLearn to create your namecard, set favourite
numbers, and create groups of contacts.

Create your namecard

1. In Menu mode, select Phonebook.

2. Select More — My namecard.

3. Enter your personal details and select Save.

rg You can send your namecard by attaching it to
amessage or email or transferring it via the
Bluetooth wireless feature.

Set favourite numbers
1. In Menu mode, select Phonebook.

2. Select the Contacts drop-down menu and
select Favourites.

40

3. Select Add.

4., Select a contact.
The contact is saved to the favourite number.

',, ® You can call this contact by touching and
d holding the assigned number in the dialling
screen.
e The first & favourite numbers will be assigned
to the favourite contacts ([@]) on the widget
toolbar.

Create a group of contacts

By creating groups of contacts, you can assign
group names, ringtones, caller ID photos, and
vibration type to each group or send messages or
emalils to an entire group. Start by creating a group:

1. In Menu mode, select Phonebook.

2. Select the Contacts drop-down menu and
select Groups.



3. Select Create group. Use advanced messaging functions
4. Set a group name, the caller ID photo, a group
ringtone, and vibration type.

5. Select Save.
6. Select Yes and add contacts to the group (if Create a text template

necessary). 1. In Menu mode, select Messages — Templates
— Text templates.

Select Create to open a new template window.
Select Tap to add text.

Enter your text and select Done.

Select Save.

LLearn to create and use templates to create new
messages, and create message folders.

Make calls or send messages from
photos

Your phone automatically adds contacts you
frequently use to the photo contacts list. From the
photo contacts, you can make calls or send
messages.

o~ N
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Create a multimedia template

1. In Menu mode, select Messages — Templates
— Multimedia templates.

2. Select Create to open a new template window.

1. In Menu mode, select Photo contacts.
2. Select a photo contact.

3. Select % to dial the number or select B to
send a message.
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3. Create a multimedia message, with a subject
and desired attachments, to use as your
template. » p. 27

4. Select Save.

Insert text templates in new messages

1. To start a new message, in Menu mode, select
Messages — Create message — a message
type.

2. Select More — Insert > Text template > a
template.

Create a message from a multimedia
template
1. In Menu mode, select Messages —> Templates
— Multimedia templates.
2. Select B next to the template you wart.
Your template opens as a new multimedia

message.
42

Create a folder to manage messages

1. In Menu mode, select Messages — My folders.
2. Select Create folder.

3. Enter a new folder name and select Done.

Move messages from a message folder to your
folders to manage them as your preferences.

Use advanced camera functions

LLearn how to capture photos in various modes and
customise camera settings.

Capture photos in Smile shot mode
1. InIdle mode, press [@] to turn on the camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Select [E@ ~ Smile shot.
4. Make any necessary adjustments.



5. Press [@].

6. Aim the camera lens at your subject.
Your phone recognises people in an image and
detects their smiles. When the subject smiles,
the phone automatically takes a photo.

Capture a series of photos
1. Inldle mode, press [81] to tun on the camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Select [E — Continuous.
4. Make any necessary adjustments.

5. Press and hold [@1] until the number of photos
you want have been taken.
The photos are saved automatically.

Capture panoramic photos

1.
2.

S

In Idle mode, press [@1] to turn on the camera.

Rotate the phone anti-clockwise to landscape
view.

Select [ ~ Panorama.
Make any necessary adjustments.
Press [@1] to take the first photo.

Slowly move the phone to the direction you
want. When you align the small white frame with
&3, the phone captures the next photo
automatically.

Repeat step 6 to complete the panoramic photo.

43
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Use camera options

Before capturing a photo, select §6% to access the
following options:

Option Function

Resolution Change the resolution option

White balance ~ Adjust the colour balance

Effects Apply a special effect
Exposuremeter  Select a type of exposure metre
Image quality Adjust the quality of your photos
Night Set whether to use Night shot mode

Before capturing a video, select {63 to access the
following options:

Option Function

Resolution Change the resolution option
White balance

Adjust the colour balance

44

Option Function

Effects Apply a special effect
Video quality

Adjust the quality of your video clips

Customise camera settings

Before capturing a photo, select §63 — £33 to access
the following:

Setting Function

Guidelines Change the preview screen

Set the camera to switch to the
Review preview screen after capturing

photos

Select a sound to accompany the
Shutter sound shutter action

Select a memory location to store
Storage new photos




Before capturing a video, select {5 — 0% to access
the following:

Setting Function

Guidelines Change the preview screen

Audio recording  Tum the audio on or off

Select a memory location to store

Storage new video clips

Use advanced music functions

Learn to prepare music files, create playlists, and
store radio stations.

Copy music files via Samsung PC Studio

1. In Menu mode, select Settings — Phone
settings — PC connections - Samsung PC
studio or Mass storage —> Save.

2. Using an optional PC data cable, connect the
multifunction jack on your phone to a PC.

3. Run Samsung PC Studio and copy files from the
PC to the phone.
Refer to the Samsung PC Studio help for more
information.

Copy music files to a memory card
1. Insert a memory card.

2. In Menu mode, select Settings — Phone
settings — PC connections ~ Mass storage
— Save.

3. Press [73™] to return to Idle mode.

4. Using an optional PC data cable, connect the
multifunction jack on your phone to a PC.
When connected, a pop-up window will appear
on the PC.

5. Open a folder to view files.
6. Copy files from the PC to the memory card.

45
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Synchronise your phone with Windows

Media Player

1. In Menu mode, select Settings — Phone
settings — PC connections — Media player —
Save.

2. Press [*5™] to retumn to Idle mode.

3. Using an optional PC data cable, connect the
multifunction jack on your phone to a PC with
Windows Media Player installed.

When connected, a pop-up window will appear
on the PC.

4. Open Windows Media Player to synchronise
music files.

5. Edit or enter your phone's name in the pop-up
window (if necessary).

6. Select and drag the music files you want to the
sync list.

7. Start synchronisation.

Create a playlist

1.

o

© 0 N O

In Menu mode, select Music player — Playlists.

2. Select Create.
3.
4. Enter a title for your new playlist and select

Select the text input field.

Done.

To assign an image to the playlist, select Tap to
edit and select an image or capture a new
photo.

Select Save.
Select the new playlist.
Select Add — Tracks.

Select the files you want to include and select
Add.



Customise your music player settings
1. In Menu mode, select Music player.
2. Select Settings.

3. Adjust the settings to customise your music
player.

Option Function

Set whether to play music in the

BIZ ciL;]ground background when you end the
[N music player
Miusle mERU Select music categories to display

in the music library screen

4. Select Save.

Store radio stations automatically

1. Plug the supplied headset into the phone’s
multifunction jack.

In Menu mode, select FM radio.
Select (») to start the FM radio.
Select More — Self-tuning.

Select Yes to confirm (if necessary).
The radio scans and saves available stations
automatically.

o~ N

Set up your favourite radio station list

1. Plug the supplied headset into the phone’s
multifunction jack.

In Menu mode, select FM radio.

Select (») to start the FM radio.

Select a radio station to add to the favourite list.
Tap Add to Favourites.

USRS
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Find information of music

Learn to access an online music service and get
information about the songs you hear while on the
move.

1. In Menu mode, select Find music.
2. Select Find music to connect to the server.

3. When the phone is successfully registered,
select (¢) to record a part of music you want to
find.

w ® Some service providers may not support this
> .
service and the database may not have
information for all songs.
e This service is unavailable while listening to
the radio.
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Use the Bluetooth wireless feature
: Zor A AR T EEee e
U Sl n ‘tOO | S an d LLearn about your phone's ability to connect to other
wireless devices for exchanging data and using
hands-free features.

app| |Ca—t|on8 Turn on the Bluetooth wireless feature

. . ) 1. In Menu mode, select Bluetooth.
Leam how to work with your mobile phone's tools o
and additional applications. 2. Select the circle in the centre to tum on the

Bluetooth wireless feature.

3. To allow other devices to locate your phone,
select Settings — On under My phone’s
visibility — a visibility option - Save — Save.
If you selected Custom, set duration that your
phone is visible.




Find and pair with other Bluetooth- Send data using the Bluetooth wireless
enabled devices feature
1. In Menu mode, select Bluetooth — Search. 1. Select the file or item from one of your phone’s

2. Select and drag a device icon into the centre. applications that you want to send.
3. Enter a PIN for the Bluetooth wireless feature or 2. Select Send via or Send URL via > Bluetooth

the other device's Bluetooth PIN, if it has one, or select More - Send namecard via —

2. Select Yes to confirm that you are wiling to
receive data from the device (if necessary).

o and select Done. Bluetooth.

a When the owner of the other device enters the . .

8 same code or accepts the connection, pairing is R_ecelve data using the Bluetooth

<§ complete. wireless feature

S 77 Youmay not need to enter a PIN depending on 1. Enter the PIN for the Bluetooth wireless feature
8 r’ the device. and select Done (if necessary).
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Use Remote SIM mode

In Remote SIM mode, you can make or answer calls
only with a connected Bluetooth hands-free car kit
via the SIM card on your phone.

To activate Remote SIM mode,
1. In Menu mode, select Bluetooth — Settings.
2. Select On under Remote SIM mode.

3. Select Save.

To use Remote SIM mode, start the Bluetooth
connection from a Bluetooth hands-free car kit.

r,, The Bluetooth hands-free car kit must be
“ authorised. To authorise, select the device and
select Authorise device.

Activate and send an SOS message

When you have an emergency, you can send an
SOS message asking for help.

'g This feature may be unavailable depending on
your region or service provider.

1. In Menu mode, select Messages — SOS
messages — Sending options.

2. Select On to tumn on the SOS messaging
feature.

Select the recipient input field.
Enter a phone number and select Done.
Select OK to save the recipients.

o o~
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Select the recipient field to open the recipient list.
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7. Select the Repeat drop-down menu and select
the number of times to repeat the SOS
message.

8. Select Save — Yes.
To send an SOS message, the touch screen and

the keys must be locked. Press the Volume key four
times.

77 Once you send an SOS message, all phone
functions will be suspended until you press and
hold [HOLD]. If you press [*@*], phone
functions will be available, but the keys will

remain locked.
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Activate the mobile tracker

When someone inserts a new SIM card in your
phone, the mobile tracker feature will automatically
send the contact number to two recipients to help
you locate and recover your phone. To activate the
mobile tracker,

1. In Menu mode, select Settings — Security —>
Mobile tracker.

Enter your password and select Confirm.

Select On to tumn on the mobile tracker.

Select the recipient field to open the recipient list.
Select the recipient input field.

Enter a phone number and select Done.

Select OK to save the recipients.

Select the sender input field.

Enter the sender’'s name and select Done.

© 0 N OO WD



10. Select Save — Accept.

Make fake calls

You can simulate an incoming call when you want to
get out of meetings or unwanted conversations. You
can also make it appear as if you are talking on the
phone by playing back a recorded voice.

Make a fake call

In Idle mode, press and hold the Volume key down.

Record a voice
1. In Menu mode, select Settings — Application

settings — Call —~ Fake call > Fake call voice.

2. Select On under Fake call voice.
3. Select Voice recording.

Select (o) to start recording.

Speak into the microphone.

When you are finished speaking, select (m).
Press the Back key.

Select Save to set the recording as a response
for the fake call.

© N O o~

Change the time delay before fake calls

1. In Menu mode, select Settings — Application
settings —> Call — Fake call > Fake call timer.

2. Select an option and select Save.
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Record and play voice memos 3. Control playback using the following icons:
con Function
(@) Pause playback

LLearn to operate your phone'’s voice recorder.

Record a voice memo (»  Resume playback
1. In Menu mode, select Voice recorder. (&)  Scan backward in afile (fouch and hold)
2. Select (¢ 1o start recording. ®)  Scan foward in a file (touch and hold)
C
é' 3. Speak your memo into the microphone. Edit i
g 4, \When you are finished speaking, select (w). it Images
g Your memo is saved automatically. Leamn to edit images and apply fun effects.
a
=N Play a voice memo Apply effects to images
S 1. In Menu mode, select My files — Sounds — 1. In Menu mode, select My files — Images —~ My
% Voice clips. photos — a photo file.
2. Select afile. 2. Select €%.
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. Select Edit ~ Effects — an effect option (filter,
style, warp, or partial blur).

. Select a variation of the effect to apply and select
Done.

To apply a blur effect to a specific area of an
image, draw a rectangle and select Blur —
Done.

. When you are finished, select Files - Save as.
. Select a memory location (if necessary).

To adjust the image automatically, select Auto
level.

Adjust the image as desired and select Done.

Save the edited image with a new file name.
Refer to steps 5-7 in "Apply effects to images.”

Transform an image

1.

Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”

. Enter a new file name for the image and select 2. Select Edit — Transform — Resize, Rotate, or
Done. Flip.
3. Rotate or flip the image as desired and select

Adjust an image

1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”

2. Select Edit > Adjust — an adjustment option 4,
(brightness, contrast, or colour).

Done.

To resize the iImage, select a size and select
Save — Done.

Save the edited image with a new file name.
Refer to steps 5-7 in "Apply effects to images.”
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Crop an image 3. Select a visual feature, enter text and select
1. Open an image to be edited. Refer to steps 1-2 Done.

in “Apply effects to images.” 4. Move or resize the visual feature or text and
2. Select Edit > Crop. select Done or OK.

3. Draw the rectangle over the area you want to 5. Save the edited image with a new flle name.
' 9 v Refer to steps 5-7 in "Apply effects to images.”
crop and select Crop — Done.

4. Save the edited image with a new file name.
Refer to steps 5-7 in “Apply effects to images.”

Insert a visual feature

1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”

2. Select Edit — Insert — a visual feature (frame,
image, clip art, emoticon, or text).
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Print images

Learn to print your images with a USB connection or
the Bluetooth wireless feature.

To print an image using a USB connection,

1. Connect the multifunction jack on your phone to
a compatible printer.

2. Openanimage. » p. 31
3. Select More — Print via - USB.
4. Set print options and print the image.

To print an image using the Bluetooth wireless
feature,

1. Open animage. » p. 31
2. Select More — Print via — Bluetooth.

3. Select a Bluetooth-enabled printer and pair with

the printer. » p. 50
4, Set print options and print the image.

Upload photos and videos to upload

LLearn to post your photos and videos to photo
sharing websites and blogs.

w Communities may be unavailable depending
>

On your region or service provider.

Set your favorite destination list
1. In Menu mode, select Communities.

2. Select Yes to set your favourite destination list (if

necessary).

57
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3. Select Accept to confirm that you agree to the
general disclaimer.

',, The first time you access Communities, you
“ will be prompted to confirm.

4. Select the destinations you want to add and
select Save.
If you selected Update lists, new destination
sites are added to the list automatically.

r,, To edit the favourite destination list or update
’ the lists, from the Communities screen, select
Settings — Preferred lists > Edit.

Upload a file

To upload photos and videos, you must have
accounts of photo sharing websites and blogs.

1. In Menu mode, select Communities.
2. Select Upload to web.
3. Select a destination you want to post to.
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4. Select Tap to add — a media file.
5. Enter the post details and select Upload.

6. Enter the user ID and password of the
destination (if necessary).

'/, You can also upload media files from Camera
d or My files by selecting &% or More — Upload
to web.

View a file
1. In Menu mode, select Communities.
2. Select a website or blog to view files.

3. Enter the user ID and password of the
destination (if necessary).

Customise the Communities settings
1. In Menu mode, select Communities.
2. Select Settings.



3. Adjust the settings. Use Java-powered games and

applications

Upload details  View details of your last upload

Learn to use games and applications powered by

Preferred lists  Edit favourite destinations award-winning Java technology.

Image resize Change the image size to upload '/, The download of Java files may not be

Unload Set your phone to upload files to ’ supported depending on the software of the

reger\/ation a destination automatically at the phone. &
scheduled time 3

Account Log in to a website or blog or log Download games or applications %

manager out 1. In Menu mode, select Games and more — §

it Change the connection profile More games. ke

profiles 9 P Your phone connects to the website preset by =

Disclaimer View the disclaimer information your service provider. %"

»

2. Search for a game or application and download it
to the phone.
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Play games Synchronise data

1. InMenu mode, select Games and more. Leamn to synchronise contacts, calendar events,
2. Select a game from the list and follow the on- tasks, and memos with the web server you have
screen instructions. specified.

77/ Avaiable games may vary, depending on your . .
u region or senvice provider. Game controls and Create a synchronisation profile

options may vary. 1. In Menu mode, select Synchronise.
2. Select Add and specify profile parameters.

Launch applications
3. When you are finished, select Save.

1. In Menu mode, select Games and more — an

application. Start synchronisation
2. Select More to access a list of various options

. - 1. In Menu mode, select Synchronise.
and settings for your application.

2. Select a synchronisation profile.

3. Select Continue to start synchronisation with the
web server you have specified.
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Create and view world clocks

Learn to view the time in another region and set
world clocks to appear on your display.

Create a world clock

1.

SERFC SN

In Menu mode, select World clock.
Select Add.

Select a time zone.

To set daylight saving time, select #.

Select OK to create your world clock.
The world clock is set as the second clock.

Select Add to add more world clocks (step 3).

Add a world clock to your display

With the dual clock widget, you can view clocks with
two different time zones on your display.

After you have created world clocks,

1. In Menu mode, select World clock.

2. Select Set as second clock.

3. Select the world clock you want to add.
4. Select Set.
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Set and use alarms

Learn to set and control alarms for important events.

Set a new alarm

1. In Menu mode, select Alarms.
2. Select Create alarm.

3. Set alarm details.

4. Select Save.

’/, The auto power-up feature sets the phone to

> .

J automatically turn on and sound the alarm at
the designated time if the phone is turned off.
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Stop an alarm
When the alarm sounds,

¢ Drag the slider to Stop to stop the alarm without
snooze.

e Drag the slider to Stop to stop the alarm with
snooze or drag the slider to Snooze to silence the
alarm for the snooze period.

Deactivate an alarm
1. In Menu mode, select Alarms.

2. Select Off next to the alarm you want to
deactivate.

Use the calculator

1. In Menu mode, select Calculator.

2. Use the keys that correspond to the calculator
display to perform basic mathematical
operations.



Convert currencies or
measurements

1. In Menu mode, select Convertor — a
conversion type.

2. Enter the currencies or measurements and units
in the appropriate fields.

Set a countdown timer

In Menu mode, select Timer.
Set the length of time to count down.
Select Start to begin the countdown.

When the timer expires, drag the slider to Stop
to stop the alert.

ML=

Use the stopwatch

In Menu mode, select Stopwatch.
Select Start to begin the stopwatch.
Select Lap to record lap times.
When you are finished, select Stop.

SIS

Create new tasks

Select Reset to clear recorded times.

In Menu mode, select Task.
Select Create task.

Enter the detalils of the task.
Select Save.

N
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Create text memos

1. In Menu mode, select Memo.
2. Select Create memo.
3. Enter your memo text and select Done.

Manage your calendar

LLearn to change the calendar view and create
events.

Change the calendar view
1. In Menu mode, select Calendar.

2. Select More — View by day or View by week.

Create an event

1. In Menu mode, select Calendar.

2. Select Create event — an event type.

3. Enter the details of the event as required.
4. Select Save.

View events

To view events of a specific date,

1. In Menu mode, select Calendar.
2. Select a date on the calendar.

3. Select an event to view its detalls.
To view all saved events,

1. In Menu mode, select Calendar.
2. Select Event list > an event type.
3. Select an event to view its details.



troubleshooting

If you are having trouble with your mobile phone, try these troubleshooting procedures before contacting a service
professional.

When you turn on your phone or while you are Code Try this to solve the problem:

using the phone, it prompts you to enter one of Your SM card is blocked, usually as a
the following codes: result of entering your PIN incorrectly

Code Try this to solve the problem: Pk several times. You must enter the PUK

When the phone lock feature is supplied by your service provider.
Password  enabled, you must enter the password \When you access a menu requiring the
you set for the phone. PIND PIN2, you must enter the PIN2 supplied
When using the phone for the first time with the SIM card. For details, contact
or when the PIN requirement is your service provider.
PIN enabled, you must enter the PIN

supplied with the SIM card. You can
disable this feature by using the PIN
lock menu.
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The phone prompts you to insert the SIM card.
Ensure that the SIM card is installed correctly.

Your phone displays “Service unavailable” or

“Network error.”

* \When you are in areas with weak signals or poor
reception, you may lose reception. Move to
another area and try again.

® You cannot access some options without a
subscription. Contact your service provider for
more detalils.

You enter a number, but the call is not dialled.

e Ensure that you have pressed the Dial key: [« ].

e Ensure that you have accessed the right cellular
network.

e Ensure that you have not set call barring for the
phone number.

Another caller cannot reach you.
e Ensure that your phone is tumed on.

e Ensure that you have accessed the right cellular
network.

e Ensure that you have not set call barring for the
phone number.

Another caller cannot hear you speaking.

e Ensure that you are not covering the built-in
microphone.

e Ensure that the microphone is close to your
mouth.

e |f using a headset, ensure that it is properly
connected.

The phone beeps and the battery icon flashes.

Your battery is low. Recharge or replace the battery to
continue using the phone.



The audio quality of the call is poor.

e Ensure that you are not blocking the phone’s
internal antenna.

e \When you are in areas with weak signals or poor
reception, you may lose reception. Move to
another area and try again.

You select a contact to call, but the call is not
dialled.

e Ensure that the correct number is stored in the
contact list.
® Re-enter and save the number, if necessary.

The battery does not charge properly or

sometimes the phone turns itself off.

e The battery terminals may be dirty. Wipe both
gold-coloured contacts with a clean, soft cloth
and try charging the battery again.

e |f the battery will no longer charge completely,
dispose of the old battery properly and replace it
with a new battery.

Your phone is hot to the touch.
When you use applications that require more power,
your phone may heat up.

This is normal and should not affect your phone’s
lifespan or performance.
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SAMSUNG
ELECTRONICS

Pinsuueg
Declaration of Conformity (R&TTE)

We, Samsung Electronics

declare under our sole responsibility that the product

GSM Mobile Phone : GT-S3653

to which this declaration relates, is in conformity with the following
standards and/or other normative documents.

SAFETY  EN60950-1 : 2001+A11:2004
EMC EN 301 489-01 V1.6.1 (09-2005)
EN 301 489-07 V1.3.1 (11-2005)
EN 301 489-17 V1.2.1 (08-2002)
SAR EN 50360 : 2001
EN 62209-1 : 2006

RADIO EN 301 511 Vv9.0.2 (03-2003)
EN 300 328 V1.7.1 (10-2006)

We hereby declare that [all essential radio test suites have been carried
out and that] the above named product is in conformity to all the
essential requirements of Directive 1999/5/EC.

The conformity assessment procedure referred to in Article 10 and
detailed in Annex(IV] of Directive 1999/5/EC has been followed with the
involvement of the following Notified Body(ies):

BABT, Balfour House, Churchfield Road,
Walton-on-Thames, Surrey, KT12 27D, UK*
Identification mark: 0168

The technical documentation kept at

Ceo168

Samsung Electronics QA Lab.

which will be made available upon request.
(Representative in the EU)

Samsung Electronics Euro QA Lab.
Blackbushe Business Park, Saxony \Way,
Yateley, Hampshire, GU46 6GG, UK*
2009. 08. 13

(place and date of issue)

PO C patz.

Yong-Sang Park / S. Manager
(name and signature of authorised person)

* Itis not the address of Samsung Service Centre. For the address or the
phone number of Samsung Service Centre, see the warranty card or contact
the retailer where you purchased your phone.
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